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Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get

maximum versatility from this machine all operators should carefully read and follow the instructions in

this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information before using this machine. It contains important information related

to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Parts of this manual are subject to change without prior notice. In no event will the company be liable

for direct, indirect, special, incidental, or consequential damages as a result of handling or operating

the machine.

Trademarks

NetWare® is a registered trademark of Novell, Incorporated. Windows® is a registered trademark of Mi-

crosoft Corporation in the United States and/or other countries.

Macintosh® is a registered trademark of Apple Computer, Incorporated.

All other products referenced are trademarks or registered trademarks of their respective companies.

Other product names used herein are for identification purposes only and might be trademarks of their

respective companies. We disclaim any and all rights in those marks.

Warning:

Use of controls or adjustment or performance of procedures other than those specified in this manual

might result in hazardous radiation exposure.

Note

The name of the applications do not appear in the following pages. Confirm which applications you will

be using before reading this manual.

Notes:

Some illustrations might be slightly different from your machine.

Certain options might not be available in some countries. For details, please contact your local dealer.

Descriptions in this manual Application

PRINTER MANAGER FOR ADMINIS-
TRATOR

Aficio Manager for Admin

PRINTER MANAGER FOR CLIENT Aficio Manager for Client
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How to Read this Manual

Symbols

In this manual, the following symbols are used:

Important

If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation

This symbol indicates the prior knowledge or preparations required before op-
erating.

Note

This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference

This symbol indicates a reference.

[ ]

Keys that appear on the machine's panel display.

Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's operation panel.

Keys on the computer's keyboard.
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Manuals for this Printer

Manuals for this Printer

There are five manuals that separately describe the procedures for the installa-
tion of a printer and for the operation and maintenance of the printer and its op-
tional equipment.

To enhance safe and efficient operation of the printer, all users should read and
follow the instructions contained in the following manuals.

❖❖❖❖ Quick Installation Guide
Describes the procedures for installing the printer.

❖❖❖❖ Setup Guide
Describes the procedures and provides necessary information about setting
up the printer and its options.

❖❖❖❖ Printer Reference
Describes the procedures and provides necessary information about using
the printer and its options. The manual is included as a PDF file on the CD-
ROM.

❖❖❖❖ Network Interface Board Quick Configuration Guide
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. The manual is pro-
vided as a PDF file which is included on the CD-ROM. (This Manual)

❖❖❖❖ Network Interface Board Type 2000 Owner's Manual
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. The manual is pro-
vided as a PDF file which is included on the CD-ROM named “Print Server
Software and Documentation” which comes with optional Network Interface
Board Type 2000.
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1. Getting Ready for Software
Installation

Support programs for the installation and configuration of Network Interface
Board are included on two CD-ROMs. One is “Printer Drivers and Utilities”
which comes with this printer and the other is “Print Server Software and Doc-
umentation” which comes with optional Network Interface Board.

You can select any of the programs listed in the Configuration Programs.
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Configuration Programs

The CD-ROM named "Printer Drivers and Utilities" includes the following util-
ities.

❖❖❖❖ PortNavi
IP Peer-to-Peer printing software
PortNavi is a utility that helps you to use network printers effectively. It is
useful in environments where two or more network printers are used. It is
recommended that you install PortNavi to use Parallel Printing and Recovery
Printing. For more information about PortNavi, see Help of PortNavi.

Note

❒ Parallel Printing and Recovery Printing are not available when you print
without using the PCL6/5e printer driver.

• PortNavi Features
Allows you to send a print job directly to the network printers without us-
ing a print server.

• Equally divides the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

Important

❒ The following settings must be the same for the specified printer and
the printers selected for Parallel Printing.

• Printers are the exact same model.

• Installed options (e.g. Paper Tray)

• Size and orientation of paper in each paper tray

• Total memory

• Installed fonts (including the downloaded fonts) 

• Allows you to print documents using other printers in the printer group
when the specified printer is busy (Recovery Printing).

Important

❒ The following settings must be the same for the specified printer and
the printers selected for Recovery Printing.

• Printers are the exact same model.

• Installed options (e.g. Paper Tray)

• Size and orientation of paper in each paper tray

• Total memory

• Installed fonts (including the downloaded fonts) 
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❖❖❖❖ PRINTER MANAGER FOR ADMINISTRATOR
A utility for the system administrator to manage printers on the network.

Reference

For the name of PRINTER MANAGER FOR ADMINISTRATOR, see in-
side the font cover of this manual.

See PRINTER MANAGER FOR ADMINISTRATOR Online Help for more
information about using PRINTER MANAGER FOR ADMINISTRATOR.

❖❖❖❖ PRINTER MANAGER FOR CLIENT
A utility for users to manage their own print status on the network.

Reference

For the name of PRINTER MANAGER FOR CLIENT, see inside the font
cover of this manual.

See PRINTER MANAGER FOR CLIENT Online Help for more informa-
tion about using PRINTER MANAGER FOR CLIENT.

The CD-ROM named "Print Server Software and Documentation" includes the
following utilities.

❖❖❖❖ MAP
Web-based configuration utility

❖❖❖❖ IPX Peer-to-Peer
IPX Peer-to-Peer printing software

❖❖❖❖ IP Peer-to-Peer
IP Peer-to-Peer printing software

❖❖❖❖ BootP Lite
Used to configure the IP parameters of Network Interface Board

❖❖❖❖ NWSetup
NetWare Print Service Configuration

The five utilities are included on the “Print Server Software and Documenta-
tion” CD-ROM, but you need this CD-ROM only if you use ”IPX Peer-to-Peer”
or “IP Peer-to-Peer” printing.

Although you can use the "MAP", "BootP Lite", or "NWSetup" utilities on the
"Print Server Software and Documentation" CD-ROM, it is easier to use the NIB
Setup Tool included on the "Printer Drivers and Utilities" CD-ROM.

To use “MAP”, “BootP Lite”, or “NWSetup” from the “Print Server Software
and Documentation” CD-ROM, see the “Owner's Manual” (Type 2000 Manual)
on the CD-ROM labeled “Print Server Software and Documentation” for instruc-
tions.
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Installing the NIB Setup Tool

A utility called NIB Setup Tool is provided to configure the printer to work in a
network environment. This section describes how to install PRINTER MANAG-
ER FOR ADMINISTRATOR, and how to run the NIB Setup Tool.

Limitation

❒ The NIB Setup Tool is supported to work with the following operating sys-
tems.

• Microsoft Windows 95/98

• Microsoft Windows NT 4.0

Installing PRINTER MANAGER FOR ADMINISTRATOR

Follow these steps to install PRINTER MANAGER FOR ADMINISTRATOR.

Preparation

You should install PRINTER MANAGER FOR ADMINISTRATOR on the
computer. If you install PRINTER MANAGER FOR ADMINISTRATOR from
a file server or run it via the network, PRINTER MANAGER FOR ADMINIS-
TRATOR might not work correctly.

Be sure to close all applications before starting the installation procedure.

A Close all the applications that are currently running.

B Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

If the setup menu starts automatically, follow the instructions on the screen.

If not, go to step C.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D In the [Install/Uninstall] tab, click [Install].

E Click [Next >].

F In the [command line for installation program] box, type the name of the CD-ROM
drive followed by “NETWORK\PRINTMAN\ADMIN\DISK1\SETUP.EXE”
(do not include the quotation marks) and then click [Finish].

Note

❒ An example would be “D:\NETWORK\PRINTMAN\ADMIN\DISK1\
SETUP.EXE” when the CD-ROM drive name is “D”.

G From the [Choose Setup Language] pop-up menu, select the language you
want to use.
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H In the [Welcome] dialog box, click [Next >].

I The Software License Agreement appears. 

After reading through all of the contents by clicking [PageDown], click [Yes] to
agree with the License Agreement.

J Select a folder to install PRINTER MANAGER FOR ADMINISTRATOR
in, and then click [Next >].

If you want to change the displayed folder, click [Browse] to select another
one.

The installation program starts.

When a confirmation dialog box appears, the installation program is com-
plete.

Running the NIB Setup Tool

A Click [Start], point to [Programs], and then click [NIB Setup Tool] in the [PRINT-
ER MANAGER FOR ADMINISTRATOR] program folder.

----Status page

The status page of Network Interface Board will be automatically printed in the
following cases:

• when the printer is turned on. 

• when Network Interface Board is reset.

This feature can be disabled with NIB Setup Tool.

To disable this feature, check [Property Sheet] in the “NIB Setup Tool” screen,
Click [Detailed...] in the [General] tab and remove the check from the box for “Print
configuration page on start up.”
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2. Windows 95/98
Configuration

Windows 95/98 Configuration

This section describes how to configure the Peer-to-peer printing. The Peer-to-
peer printing software that is included on the CD-ROM labeled ”Printer Drivers
and Utilities” which contains PortNavi or “Print Server Software and Documen-
tation” allows Windows 95/98 PCs to communicate directly with network at-
tached printers. A network server, such as NetWare or Windows NT, is not
required for Peer-to-peer printing.

There are three types of Peer-to-peer printing. You can select ”PortNavi”, “IP
Peer-to-Peer” and “IPX Peer-to-Peer” according to your network environment.

The Peer-to-peer printing software must be installed on each PC that uses Peer-
to-peer printing. Once Peer-to-peer printing software is installed, all Network
Interface Boards on the network automatically appear in the list of available
printer ports.

The Peer-to-peer printing software can also be used in networks where servers
are present; however, Server based print services are often utilized instead. Serv-
er based print services offer centralized printing management and spooling and
do not require software (other than the printer driver) to be installed on each PC.

If you use the printer in a network where servers are present, select either Peer-
to-peer printing or the server based print service.

Reference

For more information about setting IP parameters, see “Configuring the Printer
for the Network with the Operation Panel” in the “Setup Guide”.
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Using PortNavi

Important

❒ To use PortNavi, you must install PRINTER MANAGER FOR CLIENT and
use the TCP/IP protocol. For the name of PRINTER MANAGER FOR CLI-
ENT you use, see the inside the front cover of this manual.

Installing PortNavi

Follow these instructions to install PortNavi.

A  Configure the IP parameters on Network Interface Board using the opera-
tion panel.

Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the “Setup Guide”. 

B Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

Note

❒ If the installer starts automatically, use it to install PortNavi, and then go
to step F.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D In the [Install/Uninstall] tab, click [Install].

E Click [Next >].

F Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “:\NETWORK\PORTNAVI\DISK1\SETUP.EXE”
(do not include the quotation marks), and then click [Finish].

Note

❒ An example would be “D:\NETWORK\PORTNAVI\DISK1\SETUP.EXE”
when the drive letter is “D”.

G After the [Welcome] dialog box appears, click [Next >].

H If PRINTER MANAGER FOR CLIENT is not installed, the [Question] dialog
box appears. When this occurs, click [No] and install PRINTER MANAGER
FOR CLIENT. If PRINTER MANAGER FOR CLIENT is installed, click
[Yes].

I Click [Yes].

The [Question] dialog box appears.
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J If you want to read “Readme File”, click [Yes].

K After the [Setup Complete] dialog box appears, click [Yes, I want to restart my
computer now.], and click [Finish].

The computer restarts, and PortNavi can now be used. If you select “No”, be
sure to restart the computer manually before launching PortNavi for the first
time.

Deleting the Port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about PortNavi, see Help of Port-
Navi.

A From the [Printers] window, click to select the icon of the printer which uses
PortNavi to print, and then click [Properties] in the [File] menu.

B Click the [Details] tab and confirm that the PortNavi port is shown in the
[Print to the following port] box.

Remember the port name because this port should be deleted later.

C From the drop-down menu in the [Print to the following port] box, select [FILE].

D Click [Apply].

The port which is currently in use is changed.

E Click [Delete Port].

F Click to select the PortNavi port name as confirmed in step BBBB, then click
[OK]. 

The port is deleted.

G Click [OK] to close the properties.

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Port-
Navi with Windows 95/98.

Important

❒ If you want to switch the IP Peer-to-Peer port to the PortNavi port for print-
ing, delete or rename the IP Peer-to-Peer port before adding the PortNavi
port.

A Install the printer driver you want to use.
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B From the [Printers] window, click to select the installed printer icon, and
then click [Properties] in the [File] menu.

C Click the [Details] tab and click [Add Port].

D Click [Other], click to select [PortNavi] from the list and then click [OK].

The [Select Printer] dialog box appears.

The displayed items are as follows: 

Model Name: The Model Name of the printer. 

Name: The name of Network Interface Board.

Comment: Additional information about Network Interface Board.

Address: The IP address of the printer.

E Click to select the model name of the printer, and then click [OK].

If you want to select a printer which is not shown here, click [IP Address] to
type the IP address.

F Confirm that the PortNavi port name is shown in the [Print to the following
port] box, and click [OK].

The PortNavi port name is shown as "IP address@model name".

The configuration is now complete. 

When printing, select the configured printer here and print as usual. Printing
will be done automatically by PortNavi.

Accessing the Port Settings dialog box

This section describes accessing the Port Settings dialog box to enable Parallel
Printing and Recovery Printing.

Reference

For more information about the procedures for Parallel Printing and Recov-
ery Printing, see Help of PortNavi.

A Click [Start] on the taskbar, point to [Settings], and click [Printers].

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Select the [Details] tab and click [Port Settings].

The PortNavi settings dialog box appears.
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Using IP Peer-to-Peer

Important

❒ The TCP/IP protocol is required for IP Peer-to-Peer printing. Confirm that
the TCP/IP protocol is installed, if not, install it before starting the following
procedure.

Installing IP Peer-to-Peer

Follow these steps to install IP Peer-to-Peer.

Important

❒ Confirm that the printer power is turned on before starting the following pro-
cedure.

❒ If you want to switch the PortNavi port to the IP Peer-to-Peer port for print-
ing, delete or rename the PortNavi port before adding the IP Peer-to-Peer
port.

A  Configure the IP parameters on Network Interface Board using the opera-
tion panel.

Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the “Setup Guide”. 

B Insert the CD-ROM labeled “Print Server Software and Documentation”
into the CD-ROM drive.

The main screen appears.

Note

❒ If Adobe Acrobat Reader is not installed, click [Install Adobe Acrobat Reader
3.0].

C Click [CD ROM Contents].

The “Introduction” page appears.

D Click [Installation/Configuration Programs].

The “Configuration Programs” page appears.

E Click [Windows 95/98 & NT 4.x IP Peer-to-Peer Printing].

The “Windows 95/98 and NT 4.x IP Peer-to-Peer Printing” page appears. 

This page describes the functions of this utility. 

F At the bottom of the page, click the blue word [here] to begin installing.

A dialog box appears asking if the “Setup.exe” program should be started.
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G Click [Yes].

The [Welcome] dialog box appears.

H Click [Next].

The [Installation Notes] dialog box appears. 

I Click [Yes].

The [Choose Destination Directory] dialog box appears. 

J Click [Browse] to set a different folder. 

The default installation folder is C:\PROGRAM FILES\IP-P2P. 

K Click [Next].

The [Select Program Folder] dialog box appears.

This allows you to set the name of the folder that contains the shortcut links
inside the Program Folder.

L Type the name that you wish to see in “Program Folder:” and click [Next].

The files are then copied to the computer in the specified directories.

The [Information] dialog box appears. 

M Click [OK] to complete the installation.

Reference

For more information about installing IP Peer-to-Peer, see the “Owner's
Manual” (Type 2000 Manual) on the CD-ROM labeled “Print Server Soft-
ware and Documentation”.

----For manual installation

Follow these steps to install the software on your operating system (Windows
95/98).

A Insert the CD-ROM into the CD-ROM drive.

B Close all the applications that are currently running.

C Click [Start] on the task bar, and click [Run]. 

D Type <Drive>:\IP-P2P\SETUP.EXE (where <Drive> is your CD-ROM drive
name).

E Click [OK].
The [Welcome] dialog box appears.

The remaining steps are identical to H- M in the preceding procedure. ⇒ P.11 “In-
stalling IP Peer-to-Peer”
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Selecting the Printer Port

The Peer-to-peer printing software should be installed on each Windows 95/98
PC that will use Peer-to-peer printing services.

A Install the printer driver you want to use.

If the printer drivers have already been installed, you can go to the next step.

Reference

For more information about the printer drivers, see “Installing the PCL 6/5e
Printer Driver” or “Installing the PostScript Printer Driver” in the “Setup
Guide”.

B Click [Start] on the taskbar, point to [Settings], and then click [Printers]. 

The [Printers] window appears.

C Click the icon of the printer you want to set for Peer-to-peer printing.

D On the [File] menu, click [Properties].

The Printer Properties appears.

E Click the [Details] tab.

F From the [Print to the following port:] list box, select the port of the printer you
want to use for Peer-to-peer printing.

• Select the IP address of the printer. If you do not find the IP address of the
printer, the printer is not in your local subnet. Then you need to configure
IP Peer-to-Peer port manually as described in the “Owner's Manual” (Type
2000 Manual) on the CD-ROM labeled “Print Server Software and Docu-
mentation”.

G Click [OK].

Deleting the Port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about IP Peer-to-Peer, see the
“Owner's Manual” (Type 2000 Manual).

A Click [Start] on the taskbar, point to [Programs], and then click [IP-P2P]. 

The [IP-Peer to Peer Setup] window appears.

B Click [Printers...].

C Click [Find Printers].

Available printers appear.
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D Click to select the port you want to delete from “Unit Name” list.

E Click [Delete].
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Using IPX Peer-to-Peer

Important

❒ The IPX protocol is required for IPX Peer-to-Peer printing. Confirm that the
IPX protocol is installed, if not, install it before starting the following proce-
dure.

Installing IPX Peer-to-Peer

Follow these steps to install IPX Peer-to-Peer.

A Insert the CD-ROM labeled “Print Server Software and Documentation”
into the CD-ROM drive.

The main screen appears.

Note

❒ If Adobe Acrobat Reader is not installed, click [Install Adobe Acrobat Reader
3.0].

B Click [CD ROM Contents].

The “Introduction” page appears.

C Click [Installation/Configuration Programs].

The “Configuration Programs” page appears.

D Click [Windows 95/98 & NT 4.x IPX Peer-to-Peer Printing].

The “Windows 95/98 and NT 4.x IPX Peer-to-Peer Printing” page appears. 

This page describes the functions of this utility. 

E At the bottom of the page, click the blue word [here] to begin installing.

A dialog box appears asking if the “Setup.exe” program should be started.

F Click [Yes].

The [Welcome] dialog box appears.

G Click [Next].

The [Installation Notes] dialog box appears.

H  Click [Yes].

The files are then copied to the computer in the specified directories.

The [Installation Complete] dialog box appears. 

I Click [Finish] to complete the installation.
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----For manual installation

Follow these steps to install the software on your operating system (Windows
95/98).

A Insert the CD-ROM into the CD-ROM drive.

B Close all the applications that are currently running.

C Click [Start] on the taskbar, and click [Run]. 

D Type <Drive>:\IPX-P2P\SETUP.EXE (where <Drive> is your CD-ROM
drive name).

E Click [OK].
The [Welcome] dialog box appears.

The remaining steps are identical to G - I in the preceding procedure. ⇒ P.15 “In-
stalling IPX Peer-to-Peer”

Selecting the Printer Port

The Peer-to-peer printing software should be installed on each Windows 95/98
PC that will use Peer-to-peer printing services.

A Install the printer driver you want to use.

If the printer drivers have already been installed, you can go to the next step.

Important

❒ Using IPX Peer-to-Peer printing, confirm that the printer power is turned
on before continuing the following steps.

Reference

For more information about the printer drivers, see “Installing the PCL 6/5e
Printer Driver” or “Installing the PostScript Printer Driver” in the “Setup
Guide”.

B Click [Start] on the taskbar, point to [Settings], and then click [Printers]. 

The [Printers] window appears.

C Click the icon of the printer you want to set for the Peer-to-peer printing.

D On the [File] menu, click [Properties].

The Printer Properties appears.

E Click the [Details] tab.

F From the [Print to the following port:] list box, select the port of the printer you
want to use for Peer-to-peer printing.
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• Select the printer name. The printer name is shown in "Peer-to-Peer Con-
nection Information" on the network configuration page. The default set-
ting of the printer name is “RDP_” followed by the 6 digit serial number.

G Click [OK].
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3. Windows NT 4.0
Configuration

Windows NT 4.0 Configuration

There are several options for setting up printing in a Windows NT environment.

• If a NetWare server is present, NetWare print services might be used by fol-
lowing the NetWare Configuration instructions in this guide.

• Peer-to-peer print services can be available by using “PortNavi” or “IP Peer-
to-Peer”.

• LPR print services can be used via TCP/IP by following the instructions in
this section.

Windows NT printing is very flexible. It is possible to configure the individual
Windows NT or Windows 95/98 workstations to print using a different protocol
from the Windows NT server. For example, a Windows NT server could be con-
figured to print to Network Interface Board via TCP/IP using the instructions in
this section. Network Interface Board could then be designated as shared on the
NT server, allowing workstations to print via the NT server using a different
protocol (such as NetBEUI).

The optimum Windows NT printing configuration depends on the particular
environment and user as well as administrator experience and preferences. Gen-
erally, LPR printing over TCP/IP covered in the following instructions is the
best choice for environments where TCP/IP is already in use.
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Using PortNavi

Important

❒ To use PortNavi, you must install PRINTER MANAGER FOR CLIENT and
use the TCP/IP protocol. For the name of PRINTER MANAGER FOR CLI-
ENT you use, see the inside of the front cover of this manual.

Installing PortNavi

Follow these instructions to install PortNavi.

A  Configure the IP parameters on Network Interface Board using the opera-
tion panel.

Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the “Setup Guide”. 

B Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

Note

❒ If the installer starts automatically, use it to install PortNavi, and then go
to step F.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D In the [Install/Uninstall] tab, click [Install].

E Click [Next >].

F Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “:\NETWORK\PORTNAVI\DISK1\SETUP.EXE”
(do not include the quotation marks), and then click [Finish].

Note

❒ An example would be “D:\NETWORK\PORTNAVI\DISK1\SETUP.EXE”
when the drive letter is “D”.

G After the [Welcome] dialog box appears, click [Next >].

H If PRINTER MANAGER FOR CLIENT is not installed, the [Question] dialog
box appears. When this occurs, click [No] and install PRINTER MANAGER
FOR CLIENT. If PRINTER MANAGER FOR CLIENT is installed, click
[Yes].

I Click [Yes].

The [Question] dialog box appears.
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J If you want to read “Readme File”, click [Yes].

K After the [Setup Complete] dialog box appears, click [Yes, I want to restart my
computer now.], and click [Finish].

The computer restarts, and PortNavi can now be used. If you select “No”, be
sure to restart the computer manually before launching PortNavi for the first
time.

Deleting the Port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about PortNavi, see Help of Port-
Navi.

A From the [Printers] window, click to select the icon of the printer which uses
the PortNavi port to print, then click [Properties] in the [File] menu.

B Click to select the [Ports] tab, then confirm that the PortNavi port is shown
in the [Print to the following port(s)] box and that the check box is selected.

Remember the port name because this port should be deleted later.

C Click to select the [FILE] check box in the [Port] column.

D Click [OK] to close the Printer Properties.

The port which is currently in use is changed.

E Open the Printer Properties of the same printer.

F Click to select the [Ports] tab.

G At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the PortNavi port name as confirmed in step BBBB. 

Do not select the check box.

H Click [Delete Port].

I When the confirmation message appears, click [Yes].

The port is deleted.

J Click [OK] to close the Printer Properties.

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Port-
Navi with Windows NT 4.0.
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Important

❒ If you want to switch the IP Peer-to-Peer port to the PortNavi port for print-
ing, delete or rename the IP Peer-to-Peer port before adding the PortNavi
port.

A Install the printer driver you want to use.

B From the [Printers] window, click to select the installed printer icon then
click [Properties] in the [File] menu.

C Click to select the [Ports] tab and then click [Add Port].

D Click to select the [PortNavi] in the [Available Printer Ports] box then click [New
Port].

The [Select Printer] dialog box appears and printers on the network are
browsed. 

The displayed items are as follows: 

Model Name: The model name of the printer.

Name: The name of Network Interface Board.

Comment: Additional information about Network Interface Board.

Address: The IP address of the printer.

E Click to select the model name of the printer then click [OK].

If you want to select a printer which is not shown here, click [IP Address] to
type the IP address.

F Click [Close] in the [Printer Ports] dialog box.

G Confirm that the name of the PortNavi port is shown in the [Print to the fol-
lowing port(s)] dialog box and its check box is selected then click [OK]. 

The name of the PortNavi port is shown as "IP address@model name".

The configuration is now complete.

When printing, select the configured printer and print as usual. Printing will
be done automatically by PortNavi.

Accessing the Port Settings dialog box

This section describes accessing the Port Settings dialog box to enable Parallel
Printing and Recovery Printing.

Reference

For more information about the procedures for Parallel Printing and Recov-
ery Printing, see Help of PortNavi.

A Click [Start] on the taskbar, point to [Settings], and click [Printers].



Using PortNavi

23

3

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Select the [Ports] tab and click [Configure Port]. 

The PortNavi settings dialog box appears.



Windows NT 4.0 Configuration

24

3

Using IP Peer-to-Peer

Important

❒ The TCP/IP protocol is required for IP Peer-to-Peer printing. Confirm that
the TCP/IP protocol is installed, if not, install it before starting the following
procedure.

Installing IP Peer-to-Peer

Follow these steps to install IP Peer-to-Peer.

Important

❒ Confirm that the printer power is turned on before starting the following pro-
cedure.

A  Configure the IP parameters on Network Interface Board using the opera-
tion panel.

Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the “Setup Guide”. 

B Insert the CD-ROM labeled “Print Server Software and Documentation”
into the CD-ROM drive.

The main screen appears.

Note

❒ If Adobe Acrobat Reader is not installed, click [Install Adobe Acrobat Reader
3.0].

C Click [CD ROM Contents].

The “Introduction” page appears.

D Click [Installation/Configuration Programs].

The “Configuration Programs” page appears.

E Click [Windows 95/98 & NT 4.x IP Peer-to-Peer Printing].

The “Windows 95/98 and NT 4.x IP Peer-to-Peer Printing” page appears. 

This screen describes the functions of this utility. 

F At the bottom of the page, click the blue word [here] to begin installing.

A dialog box appears asking if the “Setup.exe” program should be started.

G Click [Yes].

The [Welcome] dialog box appears.
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H Click [Next].

The [Installation Notes] dialog box appears. 

I Click [Yes].

The [Choose Destination Directory] dialog box appears.

J Click [Browse] to set a different folder.

The default installation folder is C:\PROGRAM FILES\IP-P2P.

K Click [Next].

The [Select Program Folder] dialog box appears.

This allows you to set the name of the folder that contains the shortcut links
inside the Program Folder.

L Type the name that you want to see in the Program Folder and click [Next].

The files are then copied to the computer in the specified directories.

The [Information] dialog box appears.

M Click [OK] to complete the installation.

----For manual installation

Follow these steps to install the software on your operating system (Windows
NT 4.0).

A Insert the CD-ROM into the CD-ROM drive.

B Close all the applications that are currently running.

C Click [Start] on the taskbar, and click [Run]. 

D Type <Drive>:\IP-P2P\SETUP.EXE (where <Drive> is your CD-ROM drive
name).

E Click [OK].
The [Welcome] dialog box appears.

The remaining steps are identical to H- M in the preceding procedure. ⇒ P.24 “In-
stalling IP Peer-to-Peer” 

Selecting the Printer Port

The IP Peer-to- Peer printing software should be installed on each Windows NT
4.0 PC that uses Peer-to-peer printing services.

Important

❒ The IP Peer-to-Peer printing software must be installed before selecting the
printer port.
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❒ If you want to switch the PortNavi port to the IP Peer-to-Peer port for print-
ing, delete or rename the PortNavi port before adding the IP Peer-to-Peer
port.

A Close all the applications that are currently running.

B Insert the CD-ROM labeled "Printer Drivers and Utilities" into the CD-
ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
“Installing the PCL 6/5e Printer Driver” in the “Setup Guide” to start the instal-
lation and then go to the next step.

C The [Printer Installation] dialog box appears.

D From the [Port] list, select the IP address of the printer you want to set up,
and click [Next >].

E Follow the instructions on the screen to finish the installation of the printer
driver.

Deleting the Port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about IP Peer-to-Peer, see the
“Owner's Manual” (Type 2000 Manual).

A Click [Start] on the taskbar, point to [Programs], and then click [IP-P2P].

The [IP-Peer to Peer Setup] window appears.

B Click [Printers...].

C Click [Find Printers].

Available printers appear.

D Click to select the port you want to delete from “Unit Name” list.

E Click [Delete].
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Setting Up LPR Printing

Follow these steps to set up LPR printing.

Note

❒ In the following instructions, some fields or dialog box names may differ de-
pending on the NT service pack in use.

A  Configure the IP parameters on Network Interface Board using the opera-
tion panel.

Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the “Setup Guide”. 

B Click [Start] on the taskbar, point to [Settings], and then click [Control Panel].

C Double-click [Network] and select the [Protocols] tab to confirm that the TCP/
IP protocol is installed.

If the TCP/IP protocol is not in the list of Network Protocols, click [Add] to in-
stall it.

D Select the [Services] tab.

If Microsoft TCP/IP Printing is not on the list of Network Services, click [Add]
to install it.

E Click [Close] when all protocols and services have been added.

If the TCP/IP protocol has just been added, set the IP address and other TCP/
IP parameters.

The new protocols and services will be available after the system is restarted.

Important

❒ If the printer driver has not been installed yet, install it before continuing.

F Click [Start] on the taskbar, point to [Settings], and then click [Printers].

G Right click the appropriate printer and select [Properties].

H On the [Ports] tab, click [Add Port].

I Double-click [LPR Port] in the list of available printer ports.

J In the [Name or address of server providing lpd:] field, type the IP address of
Network Interface Board (that was assigned with the operation panel).

K In the [Name of printer or print queue on that server:] field, type “PORT1” (quo-
tation marks are not included) in capital letters and click [OK].
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L Click [Close] to close the [Printer Ports] dialog box.

The IP address of Network Interface Board is now displayed and currently se-
lected on the list of ports.

M If the printer is to be shared, click the [Sharing] tab, select Shared and type
the Share name.

N Click [OK].
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4. Dynamic Host
Configuration Protocol(DHCP)

Dynamic Host Configuration Protocol 
(DHCP)

The Dynamic Host Configuration Protocol (DHCP) provides a mechanism for
delivering IP configuration parameters, including the IP address, subnet mask
and default gateway, to devices (hosts) on an IP network. A DHCP server man-
ages the pool of available IP addresses and grants device requests for an IP ad-
dress.

At power-up, Network Interface Board broadcasts a DHCP request for an IP ad-
dress. If a DHCP server is present, the request might be processed, and an IP ad-
dress might be returned to Network Interface Board. Upon receipt of the IP
address, Network Interface Board resets, and prints a network configuration
page. The network configuration page might list the new IP address (and Subnet
mask and default gateway). Once an IP address has been assigned to Network
Interface Board, it might no longer broadcast DHCP requests.

Important

❒ The IP address of Network Interface Board assignment by DHCP works only
if Network Interface Board does not have an existing IP address.

The DHCP server leases a temporary IP address which expires after a period of
time, or leases a permanent or unlimited lease which does not expire.

Devices that are granted a temporary lease are notified before the lease expires
and asked if they want to extend the lease. Network Interface Board continues
extending its lease indefinitely (unless prohibited by your DHCP server config-
uration) and thus maintains a consistent IP address.

Important

❒ If Network Interface Board is not turned on or is not connected to the network
during the period when the DHCP server is sending requests to extend the
lease, the lease will not be extended. The DHCP server might cancel the lease
and might assign the IP address to another device. Therefore, it is highly rec-
ommended that you reserve an IP address for Network Interface Board in
your DHCP server configuration.

If you do not to use DHCP for IP address assignment, it can be disabled using
the NIB Setup Tool. The NIB Setup Tool allows you to use a Wizard or a Prop-
erty Sheet to configure Network Interface Board. Use the Property Sheet to dis-
able this feature. After you select Network Interface Board with the NIB Setup
Tool, click [Configure] and then click the [TCP/IP] tab. If you do not to use DHCP,
select [Specify an IP Address] and set the IP address, the subnet mask and the de-
fault gateway address.
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5. NetWare Configuration

Quick Setup Using the NIB Setup Tool 
Wizard

Using the NIB Setup Tool, you can easily set up a NetWare printing environ-
ment. 

Reference

For more information about setting up the NIB Setup Tool, see P.4 “Installing
the NIB Setup Tool”.

You can select [Wizard] or [Property Sheet] as an installation method.

When you configure Network Interface Board for the first time, use the Wizard
method.

If you want to use the Property Sheet method, see P.34 “NetWare 3.x - Advanced
Settings” and P.37 “NetWare 4.x, 5 - Advanced Settings”.

Note

❒ This section assumes that NetWare is functional and that the necessary envi-
ronment for NetWare Print Services is available.

❒ If you configure Network Interface Board in a NetWare environment using
the NIB Setup Tool, you should install the client software released from No-
vell in the following cases.

• Windows 95/98 in NDS mode configuration

• Windows NT 4.0 in NDS mode configuration

• Windows NT 4.0 in Bindery mode configuration

A Log on to the NetWare file server or the NDS tree as an Admin or Admin
equivalent.

B Run the NIB Setup Tool.

Reference

⇒ P.5 “Running the NIB Setup Tool”

C Click [Wizard] and click [OK].

The [Network board list] dialog box of Network Interface Board appears.

D Click [IPX protocol].

E Click to select the IPX address of Network Interface Board you are config-
uring, and click [Next >].
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Note

❒ If you do not know which Network Interface Board you are configuring,
print a network configuration page to confirm the MAC address (Network
address).

F Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].

G Type the print server name into the [Device Name] box, and click [Next >].

The default setting is “RDP_” followed by the 6 digit serial number. We rec-
ommend that you change it to something that is easier to remember or some-
thing based on the structure of your network.

H In a dialog box for selecting a network environment, click to select the [Net-
Ware] check box and click to clear the [TCP/IP] check box.

I Click [Next >].

A dialog box for configuring the NetWare environment appears.

J Select [Bindery] when printing under Bindery mode, or select [NDS] when
printing under NDS mode.

When you are using NetWare version 4.x, you should select [NDS].

K If you selected [Bindery], type into the [File Server Name:] box the name of the
file server in which a print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

L If you selected [NDS], type into the [Tree:] box the name of the NDS tree in
which the print server is created, and type the context into the [Context:] box.

Clicking [Browse], you can select a NDS tree and a NDS context among those
listed in the [Browse] dialog boxes.

As a context, object names are typed from a lower object and divided by a pe-
riod. For example, if you want to create a print server into NET under DS,
type “NET.DS”.

M Click [Next >].



Quick Setup Using the NIB Setup Tool Wizard

33

5

N Type the name of the printer into the [Printer Name] box, and the name of the
print queue into the [Print Queue Name] box.

The default setting for Printer Name is “Print Server Name” followed by “_1”
and that for Print Queue Name is “Print Server Name” followed by “_Q” (
quotation marks are not included). You can change them if necessary.

O If you have selected NDS mode, type the volume of the print queue into the
[Queue Volume] box. 

Clicking [Browse], you can select one of those shown in the [Browse] dialog
box.

P Click [Next >].

A dialog box to confirm the printing environment appears.

Q After confirming the environment, click [Next >].

If you want to change the settings, click [< Back] and make the settings again.

Clicking [Next >], the NIB Setup Tool automatically creates the Print Server,
the Printer, and the Print Queue in the NetWare network.

R After a confirmation dialog box appears, select [Quit] and click [Finish] to
exit the NIB Setup Tool.
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NetWare 3.x - Advanced Settings

This section describes how to configure your printer to use as a print server in
the NetWare 3.x environment.

Preparation

The following procedures use the Property Sheet method in configuring Net-
work Interface Board. If you configure Network Interface Board as a NetWare
print server for the first time, we recommend you use the Wizard method. For
more information, see P.31 “Quick Setup Using the NIB Setup Tool Wizard”.

Note

❒ This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

Setting Up as a Print Server

A Log on to the file server as a Supervisor or a Supervisor equivalent.

B Run the NIB Setup Tool.

Reference

⇒ P.5 “Running the NIB Setup Tool”

C Click [Property Sheet] and click [OK].

The [Browse] dialog box of Network Interface Board appears.

D Click [IPX protocol].

E Click to select the IPX address of Network Interface Board which is to be
configured, and then click [Next >].

Note

❒ If you do not know which Network Interface Board you are configuring, see the
network configuration page to confirm the MAC address (Network Address).

Basic Procedure

Installing the NIB Setup Tool

Configuring Network Interface Board

Configuring NetWare

Turning the power off and on
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F Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

G Click [Configure].

The property sheet appears.

H Click the [General] tab, and type the name of the print server into the [Device
Name] box.

I Click the [NetWare] tab, and make the following settings.

A Select [Bindery].

B In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.

C Click [OK] to close the property sheet.

D After a confirmation dialog box appears, click [OK].

J On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

K Type “PCONSOLE” from the command prompt.

F:> PCONSOLE

L Create a print queue as follows.

Note

❒ If you use a currently defined print queue, go to step M.

A From the [Available Options] menu, select [Print Queue Information] and press
the {{{{ENTER}}}} key.

B Press the {{{{INSERT}}}} key and type a print queue name.

C Press the {{{{ESC}}}} key to return to the [Available Options] menu.

M Create a printer as follows.

A From the [Available Options] menu, select [Print Server Information] and press
the {{{{ENTER}}}} key.

B To create a new print server, press the {{{{INSERT}}}} key and type a print serv-
er name.

If you use an currently defined print server, select one of the print servers
shown in the [Print Server] list.

Important

❒ Use the same name as that specified in the NIB Setup Tool. ( Step H).

C From the [Print Server Information] menu, select [Print Server Configuration].
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D From the [Print Server Configuration menu], select [Printer Configuration].

E Select the printer which is indicated as “Not Installed”.

F If you change the name of the printer, type a new name.

A name "Printer x" is assigned to the printer. “x” stands for the number of
the selected printer.

G As Type, select [Remote Other/Unkown].

The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

H Press the {{{{ESC}}}} key, and click [Yes] in the confirmation dialog box.

I Press the {{{{ESC}}}} key to return to the [Print Server Configuration] menu.

N Assign print queues to the created printer as follows.

A From the [Print Server Configuration] menu, select [Queues Serviced By Printer].

B Select the printer created in step MMMM.

C Press the {{{{INSERT}}}} key to select a queue serviced by the printer. 

Note

❒ You can select more than one queue at a time.

D Follow the instructions on the screen to make other necessary settings.

When you have finished the previous steps, confirm that the queues are as-
signed.

O Press the {{{{ESC}}}} key until “Exit?” appears, and select [Yes] to exit PCON-
SOLE.

P Turn the printer power off and on.

Note

❒ To confirm that the printer is configured correctly, type as follows from the
command prompt.

F:> USERLIST

❒ If the printer works as configured, the name of the print server appears as
an attached user.
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NetWare 4.x, 5 - Advanced Settings

This section describes how to configure your printer to use as a print server in
the NetWare 4.x and 5 environment.

❖❖❖❖ To use NetWare 5

• Load the IPX protocol into the file server in advance.

• You cannot use Pure IP and NDPS (Novell Distributed Print Services)
mode.

Preparation

The following procedures use the Property Sheet method in configuring Net-
work Interface Board. If you configure Network Interface Board as a NetWare
print server for the first time, we recommend you use the Wizard method. For
more information, see P.31 “NetWare Configuration”.

Note

❒ This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

❒ You should install the client software released from Novell on the Windows
before running the NIB Setup Tool for configuring in NDS mode or using
Windows NT 4.0.

Setting Up as a Print Server

Important

❒ You can set up the print server using NDS or Bindery mode in NetWare 4.x,
5. The following procedure is for setting up the print server using NDS mode
in NetWare 4.1. When you set up the print server using Bindery mode, use
the NIB Setup Tool Wizard. ⇒ P.31 “Quick Setup Using the NIB Setup Tool Wiz-
ard”

Basic Procedure

Installing the NIB Setup Tool

Configuring Network Interface Board

Configuring NetWare

Turning the power off and on
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A Log on to the file server as an Admin or an Admin equivalent.

B Run the NIB Setup Tool.

Reference

⇒ P.5 “Running the NIB Setup Tool”

C Click [Property Sheet] and click [OK].

The [Browse] dialog box of Network Interface Board appears.

D Click [IPX protocol].

E Click to select the IPX address of Network Interface Board which is to be
configured, and click [Next >].

Note

❒ If you do not know which Network Interface Board you are configuring,
see the network configuration page to confirm the MAC address (Network
Address).

F Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

G Click [Configure].

The property sheet appears.

H Click the [General] tab, and type the name of the print server into the [Device
Name] box.

I Click the [NetWare] tab, and make the following settings.

A Select [NDS].

B Type into the [Tree:] box the name of the NDS tree in which the print
server is created, and type the context into the [Context:] box.

Clicking [Browse], you can select a NDS tree and a NDS context among
those listed in the [Browse] dialog boxes.

As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type "NET.DS".
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C Click [OK] to close the property sheet.

D After a confirmation dialog box appears, click [OK].

J On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

K From Windows, run NWAdmin.

Reference

For more information about NWAdmin, see the documentation that comes
with NetWare.

L Create a print queue as follows.

A Select the container object the print queue is located in among those in
the directory tree, and click [Create] on the [Object] menu.

B In the [Class of new object] box, click to select “Print Queue”, and click
[OK].

C In the [Print Queue name] box, type the name of the print queue.

D In the [Print Queue Volume] box, click the [Browse] button.

E In the [Available objects] box, click to select the volume in which the print
queue is created, and click [OK].

F After confirming the settings, click [Create].

M Create a printer as follows.

A Select the container object the printer is located in, and click [Create] on
the [Object] menu.

B In the [Class of new object] box, click “Printer”, and click [OK]. When you
are using NetWare 5, click “Printer (Non NDPS)”.

C In the [Printer name] box, type the name of the printer.

D Click to select [Define additional properties] to check a box, and click [Create].

N Assign print queues to the created printer as follows.

A Click [Assignments], and click [Add] in the [Assignments] group.

B In the [Available objects] box, click the queue created in step LLLL, and click
[OK].

C Click [Configuration], and in the [Printer type] box, select [Parallel] using the
dropdown menu, and then click [Communication].

D Click [Manual load] in the [Communication type] group, and click [OK].

E After confirming the settings, click [OK].

O Create a print server as follows.

A Select the context specified using the NIB Setup Tool (step IIII-AAAA), and on
the [Object] menu, click [Create].

B In the [Class of new object] box, click “Print Server”, and click [OK].
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C In the [Print Server name] box, type the name of the print server.

Important

❒ Use the same name as that specified using the NIB Setup Tool. (Step H)

D Click [Define additional properties] to check a box, and click [Create].

P Assign the printer to the created print server as follows.

A Click [Assignments], and click [Add] in the [Assignments] group.

B In the [Available objects] box, click to select the printer created in step MMMM,
and click [OK].

C After confirming the settings, click [OK].

Q Turn the printer power off and on.

Note

❒ If the printer works as configured, the name of the print server appears as
an attached user.
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Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

Note

❒ This section assumes that the client has NetWare client applications installed
and is correctly configured to communicate with a NetWare print server. If
not, install the necessary applications before starting the setup procedure.

Windows 95/98

Follow these steps to set up a Windows 95/98 client. 

Preparation

Log on to the NetWare file server before starting the following procedure.

A Install the printer driver you want to use as “Local printer”.

Reference

For more information about installing the printer driver, see“Installing the
PCL 6/5e Printer Driver” in the “Setup Guide” and “Installing the PostScript
Printer Driver” in the “Setup Guide”.

Note

❒ Any port is selected during the installation, however, LPT1 is recommend-
ed.

B Click [Start], point to [Settings], and then click [Printers].

C In the [Printers] window, click the icon of the printer you want to use. 

D On the [File] menu, click [Properties].

E Click the [Details] tab, and click [Add Port].

F Click [Network] and click [Browse].

G On the network tree, double-click the name of the file server.

The queues appear.

H Click the queue you want to print, and click [OK].

I Click [OK].

In the [Print to the following port] box, a network path to the printer appears.

J Click [OK] to close the Printer Properties, and again, open it.
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K Click the [Printer Settings] tab.

L Clear the [Form feed] and [Enable banner] check boxes.

Note

❒ You should not select these check boxes because they should be specified
using the printer driver. If they are selected, the printer might not print
correctly.

When Using the PostScript Printer Driver

Follow these steps to set up for the PostScript Printer Driver

A Click the [PostScript] tab. 

B Click [Advanced].

C Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check
boxes.

M Click [OK] to close the Printer Properties.

Windows NT 4.0

Follow these steps to set up a Windows NT 4.0 client.

Preparation

Log on to the NetWare file server before starting the following procedure.

A Double-click the [Network Neighborhood] icon on the desktop and navigate to
the queue you want to use, and then double-click it.

The [Printers] dialog box appears.

B Click [No].

C Close all the applications that are currently running.

D Insert the CD-ROM labeled "Printer Drivers and Utilities" into the CD-
ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
“Installing the PCL 6/5e Printer Driver” and “Installing the PostScript Printer
Driver” in the “Setup Guide” to start the installation and then go to the next
step.

E The [Printer Installation] dialog box appears.

F From the [Port] list, select the queue you selected in step AAAA, and click [Next >].

G Follow the instructions on the screen to finish the installation of the printer
driver.
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Windows 3.1x

Follow these steps to set up a Windows 3.1x client. 

Note

❒ This section assumes that the client software released from Novell is installed
on the client computer.

A Install the printer driver you want to use as “Local printer”.

Reference

For more information about installing the printer driver, see “Installing the
PCL6/5e Printer Driver” and “Installing the PostScript Printer Driver” in the
“Setup Guide”.

B Double-click the [Printers] icon on [Control Panel].

C In the [Installed Printers] box, click to select the printer driver you want to use,
and then, click [Connect].

D In the [Ports] box, click “LPT1”, and click [Network].

The [NetWare Printer Connections] dialog box appears.

E In the [Ports] box, click “LPT1”, and in the [Resources] box, click the queue
you want to print.

Note

❒ You should log on to the file server in order to see the print queues.

F Click [Capture].

The specified queue is captured to the LPT1.

G Click [LPT Settings].

The [NetWare Settings] dialog box appears.

H Clear the [Form Feed] and [Enable Banner] check boxes.

Note

❒ You should not select these check boxes, because they should be specified
using the printer driver. If they are selected, the printer might not print
correctly.

I Click [OK] to close the [NetWare Settings] dialog box.

J Close the [Network driver] dialog box.

K Click [OK] to close the [Connect] dialog box.

L Click [Close] to close the [Printers] dialog box.
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6. Macintosh Configuration

Configuring a Macintosh

This section describes how to configure a Macintosh computer to use EtherTalk.
The actual procedures to configure a Macintosh may differ depending on the
version of the Mac OS. If you are not using Mac OS 8, see the manual that comes
with your version of the Mac OS for more information.

Changing to EtherTalk

Reference

For more information about installing the software required for EtherTalk,
see the Macintosh manuals.

A Open [Control Panels], and double-click the [AppleTalk] icon.

B Select [Ethernet] from the [Connect via:] pop-up menu.

C If you change zones, select a name from the [Current zone:] pop-up menu.

D Close the [AppleTalk] control panels.

E Restart the Macintosh.

Changing Printer Name

If the network has several same model printers, the names will be the same.
Printers that have the same name will have their names changed slightly in the
Chooser. For example, three printers named “printer” will appear in the chooser
as “printer0”, “printer1” and “printer2”.

Use applications such as Apple Printer Utility or LaserWriter Utility to change
printer names in the Macintosh EtherTalk environment. These utilities are dis-
tributed by Apple Computer, Inc.
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7. UNIX Configuration

UNIX Configuration 

UNIX printing utilizes a line printer daemon (lpd) to direct jobs to the printer.
With printer-based lpd, Network Interface Board acts as the line printer daemon
host and accepts print jobs directly. 

TCP/IP configuration of Network Interface Board is needed for all versions of
UNIX. See the “Owner's Manual” (Type 2000 Manual) for lpd configuration.

Note

❒ Be sure to turn the printer off and on after changing the network configura-
tion.

Reference

For information about setting IP parameters, see “Configuring the Printer for
the Network” in the “Setup Guide” that comes with the printer.

Setting the IP Address

The IP address of Network Interface Board may initially be set in a variety of
ways; including with the MAP utility when a NetWare server is present, with
the UNIX bootp daemon, with rarp, or with the standard UNIX command line
utility, arp.

The following instructions use arp, but the other methods may be used instead,
depending on user preference.

For more information about using one of the other methods, see the “Owner's
Manual” (Type 2000 Manual).

A Turn the printer off and then on and wait for the power-up network status
page to print.

B Add an entry to the hosts file (usually etc/hosts) that includes the printer's
name and the IP address. 

For example, to name the printer and associate it with an IP address of
197.42.211.5, place the following entry in the hosts file:197.42.211.5 <Printer-
Name>

C At the UNIX command prompt, type: arp -s <desired_IP_address>
<NIB_Ethernet_address>

(The Ethernet address is listed on the network status page as Network Ad-
dress.) 

For example, arp -s 197.42.211.5 00:40:AF:13:A2:70
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D At the UNIX command prompt, type: ping <desired_IP_address>

For example, ping 197.42.211.5. Network Interface Board will not respond to
this ping command, but will read the IP address.

E After a few minutes (usually between 1 and 2 minutes, but possibly up to
5 minutes on very large or busy networks), Network Interface Board will
reset and print its network status page.

The new IP address will be listed in the TCP/IP Network Information section.

If the status page is not printed, recheck the Ethernet address of Network In-
terface Board entry in the arp command.

Once the status page is printed, the new IP address may also be verified with
the ping command.

Setting Other TCP/IP Parameters

Once the IP address is set, Network Interface Board can be configured via telnet
or with a standard web browser.

The following steps describe configuration with a standard browser.

For more information about configuring via telnet, see the “Owner's Manual”
(Type 2000 Manual).

A In the browser, connect to http://<NIB_IP_address>

For example, http://197.42.211.5

B At Home Page of Network Interface Board, click Network Configuration.

C Many of the configuration options are password protected.

The default password is: sysadm

The password is case sensitive.

To change the password, select Change Password in the System column.

D Select Setup TCP/IP in the Protocols column and change the settings as ap-
propriate.

If unsure of the correct Subnet mask, and the first number in the IP address of
Network Interface Board is from 192 to 254, then use 255.255.255.0 as the Sub-
net mask.

E Type the sysadm password in the appropriate box and click Accept Set-
tings.

After a few seconds, the screen should report that the update was successful.

Click the Back Arrow icon twice to return to the Network Configuration page.

F Optional: Click Configure Status Page in the Printer column to define pow-
er-up status page settings, for example, disabling the power-up status page.
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G The changes made to Network Interface Board do not take effect until the
unit is reset.

Click Reset in the System column and click Reset Unit.

After a few seconds a message should appear on the screen saying that the
unit was reset.

TCP/IP configuration is now complete.
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Windows 2000 Configuration

This manual describes the procedures and provides necessary information
about setting up and using the printer under the network environment using
Windows 2000. It is useful to see “Network Interface Board Type 2000 Quick
Configuration Guide” for further information in addition to this manual.

See “Addendum for Printer Reference” to install the printer driver.

Addendum for
Network Interface Board  Quick Configuration Guide
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Configuration Programs

❖❖❖❖ PortNavi
IP Peer-to-Peer printing software
PortNavi is a utility that helps you to use network printers effectively. It is
useful in environments where two or more network printers are used. It is
recommended that you install PortNavi to use Parallel Printing and Recovery
Printing. For more information about PortNavi, see Help of PortNavi.

Important

❒ If you upgrade to Windows 2000 from Windows 95/98, PortNavi must be
uninstalled prior to install Windows 2000. And then reinstall it in a Win-
dows 2000 environment.

Note

❒ Parallel Printing and Recovery Printing are not available when you print
without using the PCL 6/5e printer driver.

• PortNavi Features
Allows you to send a print job directly to the network printers without us-
ing a print server.

• Equally divides the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

Important

❒ The following settings must be the same for the specified printer and
the printers selected for Parallel Printing.

• Printers are the exact same model.

• Installed options (e.g. Paper Tray)

• Size and orientation of paper in each paper tray

• Total memory

• Installed fonts (including the downloaded fonts) 

• Allows you to print documents using other printers in the printer group
when the specified printer is busy (Recovery Printing).

Important

❒ The following settings must be the same for the specified printer and
the printers selected for Recovery Printing.

• Printers are the exact same model.

• Installed options (e.g. Paper Tray)

• Size and orientation of paper in each paper tray

• Total memory

• Installed fonts (including the downloaded fonts) 
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❖❖❖❖ PRINTER MANAGER FOR ADMINISTRATOR
A utility for the system administrator to manage printers on the network.

Reference

For the name of PRINTER MANAGER FOR ADMINISTRATOR, see in-
side the front cover of paper manual that comes with this printer.

See PRINTER MANAGER FOR ADMINISTRATOR Online Help for more
information about using PRINTER MANAGER FOR ADMINISTRATOR.

❖❖❖❖ PRINTER MANAGER FOR CLIENT
A utility for users to manage their own print status on the network.

Reference

For the name of PRINTER MANAGER FOR CLIENT, see inside the front
cover of paper manual that comes with this printer.

See PRINTER MANAGER FOR CLIENT Online Help for more informa-
tion about using PRINTER MANAGER FOR CLIENT.

Important

❒ Configuration programs of IP Peer-to-Peer and IPX Peer-to-Peer which is in-
cluded on the CD-ROM labeled “Print Server Software and Documentation”
comes with optional Network Interface Board, are not guaranteed to work
correctly in the Windows 2000 environment.
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Installing the NIB Setup Tool

A utility called NIB Setup Tool is provided to configure the printer to work in a
network environment. This section describes how to install PRINTER MANAG-
ER FOR ADMINISTRATOR, and how to run the NIB Setup Tool.

Installing PRINTER MANAGER FOR ADMINISTRATOR

Follow these steps to install PRINTER MANAGER FOR ADMINISTRATOR.

Preparation

You should install PRINTER MANAGER FOR ADMINISTRATOR on the
computer. If you install PRINTER MANAGER FOR ADMINISTRATOR from
a file server or run it via the network, PRINTER MANAGER FOR ADMINIS-
TRATOR might not work correctly.

Be sure to close all applications before starting the installation procedure.

A Close all the applications that are currently running.

B Insert the CD-ROM labeled “Printer Drivers and Utilities” into the  CD-
ROM drive.

If the setup menu starts automatically, follow the instructions on the screen.

If not, go to step C.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D Click [Add New Programs], and then click [CD or Floppy].

E Click [Next >].

F In the [Open] box, type the name of the CD-ROM drive followed by “NET-
WORK\PRINTMAN\ADMIN\DISK1\SETUP.EXE” (do not include the
quotation marks) and then click [Finish].

Note

❒ An example would be “D:\NETWORK\PRINTMAN\ADMIN\DISK1
\SETUP.EXE” when the CD-ROM drive name is “D”.

G From the [Choose Setup Language] pop-up menu, select the language you
want to use.

H In the [Welcome] dialog box, click [Next >].

I The Software License Agreement appears. 

After reading through all of the contents by clicking [PageDown], click [Yes] to
agree with the License Agreement.
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J Select a folder to install PRINTER MANAGER FOR ADMINISTRATOR
in, and then click [Next >].

If you want to change the displayed folder, click [Browse] to select another
one.

The installation program starts.

When a confirmation dialog box appears, the installation program is com-
plete.

Running the NIB Setup Tool

A Click [Start], point to [Programs], and then click [NIB Setup Tool] in the [PRINT-
ER MANAGER FOR ADMINISTRATOR] program folder.

----Status page

The status page of Network Interface Board will be automatically printed in the
following cases:

• when the printer is turned on. 

• when Network Interface Board is reset.

This feature can be disabled with NIB Setup Tool.

To disable this feature, check [Property Sheet] in the “NIB Setup Tool” screen,
Click [Detailed...] in the [General] tab and remove the check from the box for “Print
configuration page on start up.”
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Using PortNavi

Important

❒ To use PortNavi, you must install PRINTER MANAGER FOR CLIENT and
use the TCP/IP protocol. For the name of PRINTER MANAGER FOR CLI-
ENT you use, see the inside the front cover of paper manual that comes with
this printer.

Installing PortNavi

Follow these instructions to install PortNavi.

A  Configure the IP parameters on Network Interface Board using the opera-
tion panel.

Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the “Setup Guide”.

B Insert the CD-ROM labeled “Printer Drivers and Utilities” into the  CD-
ROM drive.

Note

❒ If the installer starts automatically, use it to install PortNavi, and then go
to step F.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D Click [Add New Programs], and then click [CD or Floppy].

E Click [Next >].

F Type the name of the CD-ROM drive in the [Open] box, followed by
“:\NETWORK\PORTNAVI\DISK1\SETUP.EXE” (do not include the
quotation marks), and then click [Finish].

Note

❒ An example would be “D:\NETWORK\PORTNAVI\DISK1\SETUP.EXE”
when the drive letter is “D”.

G After the [Welcome] dialog box appears, click [Next >].

H If PRINTER MANAGER FOR CLIENT is not installed, the [Question] dialog
box appears. When this occurs, click [No] and install PRINTER MANAGER
FOR CLIENT. If PRINTER MANAGER FOR CLIENT is installed, click
[Yes].

I Click [Yes].

The [Question] dialog box appears.
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J If you want to read “Readme File”, click [Yes].

K After the [Setup Complete] dialog box appears, click [Yes, I want to restart my
computer now.], and click [Finish].

The computer restarts, and PortNavi can now be used. If you select “No”, be
sure to restart the computer manually before launching PortNavi for the first
time.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about PortNavi, see Help of Port-
Navi.

A From the [Printers] window, click to select the icon of the printer which uses
PortNavi port to print, and then click [Properties] in the [File] menu.

B Click to select the [Ports] tab, then confirm that the PortNavi port is shown
in the [Print to the following port(s)] box and that the check box is selected.

Remember the port name because this port should be deleted later.

C Click to select the [FILE] check box in the [Port] column.

D Click [OK] to close the Printer Properties.

The port which is currently in use is changed.

E Open the Printer Properties of the same printer.

F Click to select the [Ports] tab.

G At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the PortNavi port name as confirmed in step B.

H Click [Delete Port].

I When the confirmation message appears, click [Yes].

The port is deleted.

J Click [OK] to close the Printer Properties.



8

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Port-
Navi with Windows 2000.

Important

❒ If you want to switch the IP Peer-to-Peer port to the PortNavi port for print-
ing, delete the IP Peer-to-Peer port before adding the PortNavi port.

A Install the printer driver you want to use.

B From the [Printers] window, click to select the installed printer icon then
click [Properties] in the [File] menu.

C Click to select the [Ports] tab and then click [Add Port].

D Click to select [PortNavi] in the [Port types] box then click [New Port].

The [Select Printer] dialog box appears and printers on the network are
browsed. 

The displayed items are as follows: 

Model Name: The model name of the printer.

Name: The name of Network Interface Board.

Comment: Additional information about Network Interface Board.

Address: The IP address of the printer.

E Click to select the model name of the printer then click [OK].

If you want to select a printer which is not shown here, click [IP Address] to
type the IP address.

F Click [Close] in the [Printer Ports] dialog box.

G Confirm that the name of the PortNavi port is shown in the [Print to the fol-
lowing port(s)] dialog box and its check box is selected then click [OK]. 

The name of the PortNavi port is shown as "IP address@model name".

The configuration is now complete.

When printing, select the configured printer and print as usual. Printing will
be done automatically by PortNavi.
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Accessing the port settings dialog box

This section describes accessing the Port Settings dialog box to enable Parallel
Printing and Recovery Printing.

Reference

For more information about the procedures for Parallel Printing and Recov-
ery Printing, see Help of PortNavi.

A Click [Start] on the taskbar, point to [Settings], and click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Select the [Ports] tab and click [Configure Port]. 

The PortNavi settings dialog box appears.
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Standard TCP/IP Printing

Standard TCP/IP is a standard port of Windows 2000 to enable Peer-to-Peer
printing under the network environment.

For more information about settings of Standard TCP/IP, see Help of Windows
2000.
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NetWare Configuration

This section describes how to set up a Windows 2000 client.

For information about server settings, see “Network Interface Board Type 2000
Quick Configuration Guide” that comes with this printer.

Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

Follow these steps to set up a Windows 2000 client.

Preparation

Log on to the NetWare file server before starting the following procedure.

A Double-click the [My Network Places] icon on the desktop and navigate to the
queue you want to use, and then double-click it.

The [Printers] dialog box appears.

B Click [No].

C Close all the applications that are currently running.

D Insert the CD-ROM labeled "Printer Drivers and Utilities" into the CD-
ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
"Installing the PCL 6/5e Printer Driver" and "Installing the PostScript Printer
Driver" in the "Setup Guide" to start the installation and then go to the next
step.

E The [Printer Installation] dialog box appears.

F From the [Port] list, select the queue you selected in step A, and click [Next >].

G Follow the instructions on the screen to finish the installation of the printer
driver.
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